Practical Strategies to Make Your Next Project Profitable

Matthew Nicholas
Revay and Associates Ltd

Toronto
August 26, 2017
Profit in Construction
Profit In Construction

» Contractors Rely on Profits – a Top Priority
» Profit Margin is Crucial on Fixed Price Contracts
» Continuity of Business
» Measure of Success
» Source of Capital to Expand Business
Average Profit Margin

Construction
<= $5M; 265,307 contractors

89%
11%

Drywall & Insulation
<= $5M; 11,215 subcontractors

83%
17%

Source: 2015 Canadian Industry Statistics, Govt of Canada
Lack of Profit In Construction

Source: 1965 NRC Survey

» Lack of Proper Planning

» Inadequate Scheduling

» Lack of Detailed Cost Information

» Lack of Supervisory Training
Profit Fade

» Aggressive Bidding
» Poor or Overly Optimistic Estimating
» Inaccurate Job Costing
» Downward Adjustment of Tender Price
» Lack of Project Control
» Inadequate Resources/Training
» Unbillable Extra Work/Changes
» Sloppy Site Management
» Unexpected Jobsite Challenges.
How to Improve Your Profit Margin?
Practical Strategies
Project Management

Project management is the art of directing and coordinating human and material resources throughout the life of a project by using modern management techniques to achieve predetermined objectives of scope, cost, time, quality and participation satisfaction.
How to Achieve Profitability.....

» Scrutinize Contract
» Estimate Accurately
» Schedule Tasks
» Monitor Schedule
» Monitor Costs
» Monitor Productivity
» Manage Changes

» Evaluate Earned Value
» Maintain Documentation
» Manage Risks
» Employ Qualified Personnel
» Resolve Disputes Amicably
» Conduct Project Post Reviews
Review Your Previous Jobs
Review of Past Jobs

» Were Job Costs Assigned Accurately to Projects?
» Were Your Assumptions Correct?
» Were the Methods Used to Allocate O/H Appropriate?
» Did You Spend Adequate Time to Prepare/Review Estimates?
» What Were the Causes of Delays?
» Do Certain Problems on Projects Repeat?
» Did Changes to Scope Affect Profitability?
» Is There a Correlation Between Reduced Profit and Certain
  » Job Type, Location, Contract Size or Client?
  » Estimators, Project Managers or Supervisors?
Scrutinize Your Contract

“Education is what you get when you read the fine print …
...experience is what you get when you don’t.”
Risks and Responsibilities

» The requirements, terms and conditions of the Prime Contract as far as they are applicable to this Subcontract, shall be binding upon the Contractor and the Subcontractor ................. In the event of any conflict between the terms of this Subcontract and the Prime Contract, the Prime Contract shall govern.

» The Subcontractor shall preserve and protect the rights of the parties under the Subcontract with respect to Subcontract Work to be performed under sub-subcontract, and shall:

(1) enter into contracts or written agreements with Sub-Subcontractors .......

(2) incorporate the terms and conditions of the Subcontract Documents into all contracts or written agreements with Sub-Subcontractors; and

(3) be as fully responsible to the Contractor for acts and omissions of Sub-Subcontractors and of persons directly or indirectly employed by them as for acts and omissions of persons directly employed by the Subcontractor.
The Sub-subcontractor shall supply all the ……… in accordance with the requirements and on the terms and conditions of:

(1) the Prime Contract (including, without limitation, such documents as drawings, specifications, instructions to bidders, general and/or special conditions, and any addenda thereto issued before the date of Sub-subcontractor’s tender closing to the Subcontractor or as modified herein),

(2) the Subcontract, to the extent the terms and conditions of the Subcontract are applicable to this Sub-subcontract, and

(3) this Sub-subcontract including the Sub-subcontract Conditions, together with those Appendices, if any, listed hereafter forming part hereof …
Contract Schedule/Delays

» The Sub-subcontractor will begin work on or about the ........and will carry on and complete Work on or before the ........generally in accordance with the Schedule attached hereto or otherwise provided for by the Prime Contract or Subcontract. ........

» ......, the contractor shall not have any claim for compensation for damages against the owner for any stoppage or delay from any cause whatsoever.
Compile Accurate Estimates
Accurate Estimate

» An Accurate Estimate:
  » Determines the True Cost
  » Includes for Job Costs, Overheads, Risks
  » Accounts for Duration and Cost of Each Task

» Labour Portion is Riskiest and Most Difficult to Estimate

» Consider Escalation of Material Cost & Wages

» Ensure All Scope is Reflected in the Baseline Budget
Estimating for Profit

» Determine Complexity by Spending Up-front Effort to Detail All Component Parts

» Review Contract Schedule or Create a Schedule before Estimating

» Utilize Data from Past (Successful) Projects

» Determine Costs Down to Resource Level

» Accommodate for Waste and Jobsite Challenges

» Always Have a Reason for Your Price
Common Estimating Errors

» Failure to Read Contract/Specifications
» Failure to Assess Risk and Uncertainty
» Failure to Consider Quality of Workmanship Required
» Failure to Review Building Codes, Permits and Inspections
» Unfamiliarity with Project Site/Access
» Lack of Historical Benchmarking Data
» Using Non-standard Structure for Estimate
» Lack of Wide Participation in Preparation of Estimates
Schedule Your On-site Work
Scheduling Affects Costs

» Overall Project Duration
» Overhead Calculation
» Deployment of Resources
» Idle Time for Equipment/Site Management
» Material Handling
» Level of Risk
Schedule For Profit …..

» To Ensure Work is Adequately Planned
» To Evaluate and Comment on Client’s Schedule
» To List Activities Required to Complete the Project
» To Allocate Duration and Provide Preferred/Pre-determined Sequences to Establish Timing of Activities
» To Determine What Physical Resources (People, Equipment, Materials, etc.) and What Quantities of Each are Required to Perform the Activities.
» To Complete the Project Faster
Other Benefits of Scheduling

» If Schedule is Prepared/Published, Everyone Knows When an Activity is Expected to Start/Finish

» Reduce Labor Costs by Considering Work Flow as Crews Move on & off the Job

» No Haggling with Client about What was Accomplished During the Previous Month

» Able to Explain the Impact of Owner Directed Changes

» Substantiate Delay or Justify Requests for EOT
Common Scheduling Problems

» Unfamiliarity with CPM
» Personnel Ill-equipped to Create CPM Schedule
» Inadequate Software for the Job
» Lack of Buy-in by the Project Team
» Activities Too General - Lack of Detail
» Logic not Fully Thought Out
» Duration not Realistic
» Resource Loading/Sequences Ignored
» Working Constraints not Included
Monitor Your Work in Progress
Monitor Progress

» Implement a System to Acquire Current and Accurate Progress Information

» Always Rely on Detailed Information

» Monitor Labour Consumption and Time

» Track Costs and Revenue
Monitor Your Schedule
Why Track Schedule …..

» To Determine Which Activities are Behind or Ahead of Schedule

» To Determine if Your Project is Behind or Ahead of Schedule

» To Produce Current Schedule to Determine How the Remaining Work will be Completed within Contract Time

» To Show Why Project Completion is Revised

» To Improve Communication during Construction

» To Study/Incorporate Impact of Changes

» To Record Progress

» To Maintain Comprehensive Schedule for Dispute Prevention
Updating Schedule

Planned Schedule

Updated Schedule

Changes  Extra Work  Access
Monitor Your Costs
Monitor Cost ….

» To Compare Actual Performance against Planned Performance

» To Have a Knowledge of Profit and Loss Throughout Project Duration

» To Provide Feedback Data to Future Project Estimation and Planning

» Inputs to Cost Control
  » Cost Baseline
  » Performance Reports
  » Change Orders
Cost Baseline (Cash Flow)

- A time-phased budget that will be used to measure and monitor cost performance on the project. It is developed by summing estimated costs by period and is usually displayed in the form of an S-curve.
Review of Cost Performance Involves...

› Tracking ‘Cost to Date’ and ‘Forecast Cost at Completion’

› Forecasting Cost at Completion

› Subjecting ‘Forecast Cost at Completion’ to Scrutiny

› Identifying Reasons for Cost Variances:
  › Wrong (Productivity) Rates
  › Operational Inefficiency
  › Unidentified Scope Changes

› Taking Steps to Avoid/Mitigate Cost Increases

› Reviewing Cost Performance Regularly to Maximise Profits
Job Cost Accounting

» Use True Job Cost Accounting to Establish Actual Cost of the Project

» Distinguish Between O/H Costs and Direct Costs

» Compare Budgeted Costs to Actual Job Costs to Measure Estimating Effectiveness, Labor Productivity and Use of Materials

» To Accurately Assign Costs to a Project, Ask Your PM to Code the Bills

» Post Job Costs in a Timely Manner to the Project

» Invoice Client on Time
Monitor Productivity
Bid Estimate: Insulation (Example)

Labour 50%
Materials 30%
General Conditions & Indirect Costs 10%
Overhead 5%
Profit 5%
Total 100%
Labour Overrun

Labour: 50%
Materials: 30%
General Conditions & Indirect Costs: 10%
Overhead: 5%
Profit: 5%
Total: 100%

55% = 10% overrun in labour
## Impact on Profitability

<table>
<thead>
<tr>
<th>Category</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labour</td>
<td>55%</td>
</tr>
<tr>
<td>Materials</td>
<td>30%</td>
</tr>
<tr>
<td>General Conditions &amp; Indirect Costs</td>
<td>10%</td>
</tr>
<tr>
<td>Overhead</td>
<td>5%</td>
</tr>
<tr>
<td>Profit</td>
<td>0%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>100%</strong></td>
</tr>
</tbody>
</table>

Wipes out all profit!
Why Measure Productivity ….

» Labour Productivity is Often the Source of Cost and Schedule Uncertainty.

» To Compare Bid Assumptions to Actual Onsite Production

» To Provide Valuable Information to Facilitate Mitigation and for Future Bids

» To Provide a Yardstick by Which to Measure Competition

» To Enable Credible Calculations of Remaining Time and ‘Forecast Cost to Complete’

» To Calculate Cost Overrun/Lost Labour, if warranted for Submission of a Claim.
Monitor Changes to Your Scope
Implement Change Management

» Manage Changes to Scope to Prevent Reduced Profitability

» Price Changes Properly

» Have an up-to-date Estimation to Completion

» Document all Change Orders

» Track, Measure and Report on Changes and Their Impact on Scope and Cost/Time (Productivity)

» Do not Let Legitimate Changes Go Unapproved
Pricing of Changes

Cost Estimate

Direct Cost
- Labour
- Material
- Equipment
- Subcontract

Impact Cost
- Time Related
- Productivity Related

Indirect Cost
- General Conditions
- Overhead
- Taxes
- Mark-up
Qualify Pricing of Changes

The price quoted is only for the direct cost of the change. We reserve the right to seek compensation for the impact on contract work and/or the cumulative effect of changes when these costs (if any) can be quantified.
Evaluate Your Earned Value
Progress Evaluation

» Measure the Amount of Progress Actually Achieved

» Predict and Prevent Overruns and Delays

» Compare Baseline Budget against Actual/Forecast

» Assess Estimated Time to Completion to Adjust Project Plans Before It is Too Late

» Have Better Visibility to Make Smarter Decisions
Earned Value Management (S-Curve Evaluation)

» Provides a Tool to Detect Ahead of Time Whether Project is Off the Rails or On the Rails

» Compare Timing of Monies Earned to When It was Originally Anticipated.

» At Any Point in Time, the Project is Considered Behind Schedule if the Earnings are Less Than Anticipated

» Compare the Scheduled Time For Anticipated Earnings to When The Value was Actually Earned to Estimate Overall Project Delay

» Able to Report on Value of Work Completed (Over budget vs. Under budget)
Earned Value Analysis

- Actual Accomplishment
- Budgeted Cost
- Planned Expenditure
- Actual Expenditure
- Target Completion
- Projected Completion

Graph showing the relationship between budgeted cost, planned expenditure, actual expenditure, and actual accomplishment over time.
Establish Document Control System
Project Documentation

» Good Documentation Tells the Project Story

» Good Records are Needed:
  » To Avoid Confusion and Support Causation
  » To Assist in Reaching Agreement by Defining Facts, Roles and Responsibilities
  » To Help Reduce Litigation Risk

» Failure to Document Costs, Events and Decisions Leads to Misunderstandings and Rejected Claims
Distribute Your Risks
Manage Risks

» Risk: Any Occurrence That is not Part of Your Scope Which has an Effect on Your Contract Price or Schedule.

» Brainstorm to Identify Potential Risks

» Don’t Take on an Unreasonable Amount of Risks

» Look for Cost-Plus or Time & Material Work

» Fixed Price Contracts are Risky (Aren’t All Bad, if You Implement Project Control Measures)

» Always Negotiate Your Position
Know Your Client & Employ Proven Site Management Personnel
Your Field Management ….

» Keeping Workers Informed, Trained, and Motivated Help Improve Productivity

» Proper Planning and Communication with Workers Lead to Improved Bottom-line

» Any Improvement in Labor Yields Significant Improvement in Bottom-line.

» Proper Planning to Minimize the Time Waiting for Materials Improves Productivity

» Keep Workers Informed on Progress Being Made on the job – Both When Ahead and When Behind
Employ Competent PM

» Able to Persuade and Negotiate Plausible Solutions

» Able to Build Customer Relations and Negotiate Contracts and/or COs

» Able to Understand Project Financials and Cash Management

» Posses Leadership Skills
Know Your Client

» Is Your Client Letting You Struggle Because You…..
  » Don’t Have the Management Skills and Knowledge
  » Work on Several Projects at the Same Time
  » Don’t Have Adequate Supervision
  » Don’t Get Paid on Time as Payment is Held Back Unduly
  » Don’t Follow Sophisticated Approach to Claims

» Does Your Client …..
  » Make a Habit of Undercutting You to Improve its Profit
  » Fail to Point Out Poor Quality Work as Soon as it is Noticed
  » Fail to Assist in Planning and Managing Your Work
  » Fail to Provide Timely Access to Work Areas
Conduct Project Post Reviews
Conduct Project Post Reviews

» Conduct Reviews on What Happened in Past Projects to Learn From Past Mistakes as well as to Reinforce Past Successes

» Ensure Challenges, Lessons Learned, and Best Practices are Captured and Used on Futures Projects.

» Watch Past Trends to Identify Patterns of Failures and Address Them

» Watch for Trends in Costs/Rates from Suppliers to Use This Info to Influence Future Negotiations

» Get a Good Understanding of Cash Flow on Past Projects and How It Relates to Various Project Metrics

» Get a Good Understanding Where You’re Most Profitable and Where You’re not.

» Review of What the Client Wanted and Their Level of Satisfaction at the End of the Project
Try to Resolve Disputes Amicably
Amicable Settlement

» Always Maintain Open Communication
» Comply with Contract Provisions
» Be Reasonable when Presenting a Claim
» Seek Amicable Settlement
  » Expedient and Final
  » Cost Effective
  » Does not Tie Up Your Resources
» Cash Flow is Critical for Your Operation
» Project is a Team Effort - Preservation of Working Relationship is Important
Conclusion

» Project Control - Powerful Tool to Prevent Profit Fade
» Use Data from Past Projects to Manage Events That Impact Profitability
» Read the Contract Carefully
» Accurately Estimate Cost to Understand the True Cost of the Project
» Monitor Time and Cost Regularly
» Control Over Labor Can Prevent Profit Fade
» Aggressively Chase Extras for All Risk Events
» Document All Events and Decisions
» Provide Better Visibility to Site Staff into How the Project is Performing

Though You Need to Operate With Lower O/H Costs, **Implement Project Controls if You Want to Increase Profitability.**
Thank You!